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PLEASE DON’T MAKE ILLEGAL COPIES

The program you’ve purchased was produced through the efforts of
many people. Everyone at id Software relies on sales of this program
to support themselves and their families. Help preserve jobs (and
keep game prices down) by honoring the copyright of this program.
Don’t make copies for others who have not paid for the right to use
DOOM. To report copyright violations to the Software Publishers
Association, call 1-800-388-PIR8 or write:

Software Publishers Association
Suite 901

1101 Connecticut Avenue NW
Washington, DC 20036

This program is protected by federal and international copyright.

IMPORTANT NOTE TO MULTIPLAYER MODE USERS
When you are playing with friends, certain rules for playing DOOM
change significantly. Full details on this are included on the
separate Multiplayer Addendum found in your game box.



THE STORY SO FAR

You’'re a marine, one of Earth’s toughest, hardened in
combat and trained for action. Three years ago, you assaulted a
superior officer for ordering his soldiers to fire upon civilians. He
and his body cast were shipped to Pearl Harbor, while you were
transferred to Mars, home of the Union Aerospace Corporation.

The UAC is a multi-planetary conglomerate with radioactive waste facilities
on Mars and its two moons, Phobos and Deimos. With no action for fifty
million miles, your day consisted of suckin’ dust and watchin’ restricted
flicks in the rec room.

For the last four years the military, UAC’s biggest supplier, has used the
remote facilities on Phobos and Deimos to conduct various secret projects,
including research on inter-dimensional space travel. So far they have been
able to open gateways between Phobos and Deimos, throwing a few gadgets
into one and watching them come out the other. Recently however, the Gate-
ways have grown dangerously unstable. Military “volunteers” entering them
have either disappeared or been stricken with a strange form of
insanity—babbling vulgarities, bludgeoning anything that breathes, and finally
suffering an untimely death of full-body explosion. Matching heads with torsos
to send home to the folks became a full-time job. Latest military reports state
that the research is suffering a small set-back, but everything is under control.

A few hours ago, Mars received a garbled message from Phobos. “We
require immediate military support. Something fraggin’ evil is coming out of
the Gateways! Computer systems have gone berserk!” The rest was
incoherent. Soon afterwards, Deimos simply vanished from the sky. Since
then, attempts to establish contact with either moon have been
unsuccessful.

You and your buddies, the only combat troop for fifty million miles were
sent up pronto to Phobos. You were ordered to secure the perimeter of the
base while the rest of the team went inside. For several hours, your radio
picked up the sounds of combat: guns firing, men yelling orders, screams,
bones cracking, then finally, silence. Seems your buddies are dead.

ITSUPTO YOU

Things aren’t looking too good. You'll never navigate off the planet on
your own. Plus, all the heavy weapons have been taken by the assault team
leaving you with only a pistol. If only you could get your hands around a
plasma rifle or even a shotgun you could take a few down on your way out.
Whatever killed your buddies deserves a couple of pellets in the forehead.
Securing your helmet, you exit the landing pod. Hopefully you can find more
substantial fire power somewhere within the station.

As you walk through the main entrance of the base, you hear animal-like
growls echoing throughout the distant corridors. They know you're here.
There’s no turning back now.



INSTALLING DOOM

The instructions for installing Ultimate DOOM are located in the
addendum included in your game box. It is recommended that you
install the Ultimate DOOM application, the DOOM.WAD file, and the
Music folder to your hard drive. If you have purchased the disk version,
you must install these files to play the game with music turned on.
Although it is possible to play DOOM directly from the CD, we
recommend you install the files listed above for acceptable speed.

OBJECT OF THE GAME

Welcome to DOOM, a lightning-fast virtual reality adventure
where you are the toughest space trooper ever to suck
vacuum. Your mission is to shoot your way through a
monster-infested holocaust, living to tell the tale if possible.

The gameplay for DOOM is quite simple. This is not a
cumbersome adventure game, but an action-oriented slugathon. You
don’t need the reflexes of a hyperactive eight-year old to win, either —
using your wits is IMPORTANT. To escape DOOM you need both brains
and the killer instinct.

USING THE MENUS

When you launch DOOM, the game will start in single player mode. To
access the game’s setup options, hold down the ‘S’ key for the Single
Player Setup dialog, or the ‘M’ key for the Multiplayer Setup dialog,
when the logo screens appear.

The single player and multiplayer setup dialogs allow you to load
additional WAD files or a saved game, as well as choose the skill level,
kill other applications, and monster, respawn and warp options. Press
the “Load WAD File...” or “Load Game...” button while holding down the
Option key to unload the current additional WAD files or saved game
files. Multiplayer setup also allows you to configure and start a
multiplayer game. See the Multiplayer Addendum for details on starting
and playing a multiplayer game.

After starting the game in single player mode, a self running demo will
begin. At this point, you can access the menubar by moving the cursor
to the top of the screen. To access the DOOM menu, press the
<Escape> key. Use the arrow keys to move the skull cursor up and
down. If you have selected either “Mouse” or “Joystick” under the
Options menu, you may also use the mouse or joystick to move the skull
cursor up and down. When the skull is adjacent to a desired selection,
press the <Return> key, <Enter> key, mouse button (when Mouse is
enabled), or joystick fire button (when Joystick is enabled) to activate
that selection. You can bring up the DOOM menu at any time by
pressing the <Escape> key.



NEW GAME (sN)
If you want to jump into the action, select this. You may also select “New
Game” from the File menu. DOOM will ask you to select the difficulty
level. Each difficulty level differs in the toughness of the enemies you’ll
face. Beware the Nightmare level of difficulty. It is definitely not suitable
for inexperienced game players.

LOADING AND SAVING YOUR GAME (F2/%2 AND F3/%3)
Games can be saved or loaded at any time during the gameplay while
playing in single player mode. To save a game, enter the name of the
game (the default name contains the episode and map/level number),
and click the Save button. To load a game, simply select the appropriate
game from the Load Game dialog. You can also switch to the Finder™
(unless you’ve “killed” it) and double-click a saved game file to load a
game, or select “Open Saved Game...” from the File menu.

QUICKSAVE: Pressing the function key <F6> (or 36), or selecting “Save”
from the File menu, allows you to Save a game without leaving the
action. If you have already saved a game, that file is overwritten when
you select “Save”, otherwise the standard file naming dialog will appear.
Pressing <F9> (or $9) or selecting the “Quickload” item from the File
menu loads in the last game you have saved.

QUIT GAME (F10/%Q)
Quit Game enables you to quit from DOOM and return to the Finder. You
may also press #Q or <F10>, or select “Quit” from the File menu to quit
DOOM.

END GAME (F7/%7)
This allows you to end the current game without exiting to the Finder or
loading a new game. You can also press <F7> or 87 to end your current
game, or select “End Game” from the File menu.

MESSAGES (F8/%8)
In DOOM, whenever you pick up an item, you’ll receive information
about the thing you just picked up. This option lets you toggle DOOM’s
messages on and off. You can also press <F8> or $8 to toggle
messages on and off, or select “Toggle Messages” from the Control
menu.



GRAPHIC DETAIL (F5/%5)
The default setting for the screen detail is LOW. If you have a Power
Macintosh or a fast 68040-based Macintosh, you may wish to select
MEDIUM or HIGH resolution. To change the graphic detail, select this
option or press <F5> or %5 to change to the next resolution. You may
also select “Graphic Detail” from the Control menu. If messages are
turned on, the current resolution will be displayed for you momentarily in
the upper left of the screen.

SCREEN SIZE (+ AND -)
Just below this option is a bar with a sliding marker. When this option is
selected, you can use the arrow keys to slide the marker back and forth
to adjust the viewing area. A smaller viewing area increases the
smoothness of the animation on slower Macintosh systems. While
playing the game you can adjust the size by pressing ‘-’ or ‘+’ on the
main keyboard (note that you do not have to hold down the Shift key).
Pressing the ‘-’ or ‘+’ key on the numeric keypad will not work.

SMALL GRAPHICS/LARGE GRAPHICS
These menu items in the Options menu allow you to change the size of
the graphics on your monitor. You may want to use “Small Graphics” to
improve performance.

SOUND VOLUME (F4/%4)
This selection also has a bar with a sliding marker, allowing adjustment
of the volume from “off” to “maximum”. These bars modify the music as
well as the sound effects volume. Press <F4> or 4 to display the volume
settings menu directly. You must also set the Macintosh’s overall sound
volume through your Sound Control Panel.

MOUSE SENSITIVITY
This selection lets you adjust the sensitivity of your mouse control. Just
below this option is a bar with a sliding marker. When this option is
selected, you can use the arrow keys to slide the marker back and forth
to adjust the sensitivity of the mouse. Also note that by selecting “Turbo”
in the Options menu you can adjust the speed of your movement while
in the game. The Turbo setting can be found in the “Movement” dialog
(press T to access it). A value of 100 is “normal”, and a setting of 255
(the maximum) is “very fast”.

GAMMA CORRECTION (F11/%G)

On some monitors, DOOM may appear too dark. Press the function key
<F11> or G to lighten the screen through five different brightness levels.

TIP: Save your game and save it often. When you die, you’re back to the
beginning of the level, toting that little pistol again. That ain't good,
especially after you progress to some of the tougher levels.



ON-SCREEN INFORMATION

DOOM provides on-screen information that’s necessary to survive.

THE STATUS BAR

G

MESSAGES

2 3 4 5 6 7

1. MAIN AMMO: In big fat numbers, you see the number of
shots you’ve got left in the weapon you’re currently using.

2. HEALTH: You start out at 100%, but you won't stay there
long. At 0% it’s time to start over. Try a little harder next time!

3. ARMS: This list of numbers shows which weapons are avail-
able. If a number is highlighted, the weapon is accessible by pressing
that number. (“1” is always available.)

4. YOUR MUG: This portrait isn't just for looks. When you're hit,
your face looks in the direction from which the damage came, telling
you which direction to return fire. Also, as you take damage you'll
begin to look like raw hamburger—as shown to the left.

5. ARMOR: Your armor helps you out as long as it lasts. Keep an
eye on it, because when it goes, you might, too.

6. KEY CARDS: You can see any keys you possess right here.
There are three key colors; Yellow, Red, and Blue.

7. AMMO: This shows how much of each type of ammo you're
carrying and the maximum amount you could carry—if you had it.

Often you'll find yourself running over various items. DOOM tells you
what you're picking up by printing a message on the screen — unless
messages are off. Press <Return> to display the last message.

THE AUTOMAP
To help you find your way around DOOM, you're equipped with an
automap device. By pressing the <Tab> key, you replace your normal
view with a top-down map of everything you’ve seen up to date. The
white arrow represents you, and points in the direction you’re looking.
You can zoom in and out by pressing ‘+’ or *-’. Press the number ‘0’ to
toggle between zoom and full view. To mark your location on the map
press the ‘M’ key. This will place a number over your location. To clear all
the numbers from the map, press the ‘C’ key.



MOVING IN THE AUTOMAP:
Using the movement keys, you can
move yourself, while viewing the
Automap. This is dangerous, since
you can't see the enemy while
viewing the Automap. To scroll the
Automap without moving yourself,
turn off Follow mode. Press the ‘F’
key to toggle Follow mode on and off.

CONTROLLING THE ACTION

Most of the play commands in DOOM are a simple keypress away. You
can use either your keyboard, mouse, joystick, and combinations of
both to move, pick up items, shoot, and open doors. Note that to use
the mouse or joystick you will need to select “Mouse” or “Joystick” from
the Options menu (or press 8 M or 38 J).

MOVING
At first, you might find yourself bumping into walls while demons beat on
you. Once you've got movement down, everything else follows. Select
“Movement...” from the Control menu to view and modify the current key
settings.

WALKING: Use the up and down keys to walk forward and backward.
TURNING: The left and right keys turn you left and right.

RUNNING: Hold down the Run key and the appropriate arrow key to
speed yourself up.

STRAFE: By holding down the Strafe key, in combination with the left or
right key, you can sidestep, rather than turn left or right. Some key
settings provide a separate “strafe” left and right (for instance, if you're
using the Main Keyboard settings, ‘O’ will cause you to sidestep to the
right while ‘L’ will cause you to turn right).

Note: Jumping is very important for successfully completing DOOM.
Though there is no jump key, you can leap from ledges by getting a
running start. The faster you are moving the further you will go.

TIP: When traveling narrow passages many players have found it useful to
examine the Automap in a magnified mode enabling them to see exactly
where to step.

JOYSTICK OR MOUSE: A number of “settings” files for various
Macintosh-compatible joysticks will be installed into your Ultimate
DOOM folder that will allow you to configure your joystick for your own
preferences. Note that if the Mouse or Joystick is enabled, the menubar
is disabled. To access the menubar simply press % K (keyboard mode), or



press the Command key equivalent of the menu item you want (i.e., ¥S
to Save). Moving the mouse cursor to the top of the screen causes the
menubar to be displayed while in keyboard mode.

PICKING UP STUFF
To pick up an object, just walk over it. You're smart, and know if you
need to take it.

USING DOORS, SWITCHES & ELEVATORS
To open most doors and operate switches, stand directly in front of them
and press the Spacebar (or other key, if you have changed the “Action”
key setting). When you successfully operate a switch, it will change in
some way (lights up, flips a handle, etc.). If a switch does not change
after a couple of tries, it is probably assigned to do a task that cannot yet
be accomplished.

LOCKED DOORS: Some doors have security locks, and
require you to have a color coded (yellow, red, and blue) .
security card or skull key to open them. Other locked doors

are operated by a switch on a nearby wall. Rather than .
walking up to the door, you'll need to operate the switch.

HIDDEN DOORS: Some doors are hidden. Many of these can

be opened by finding a switch. In some cases you just need to walk up to
the wall and press the Spacebar./Action key. If you've found a secret door,
it will open for you. There are clues that reveal a secret door — a wall that’s
shifted down or a different color, a flashing light on a wall, etc.

ELEVATORS: You'll see platforms that raise and lower. Some platforms
operate continuously, while others must be activated. Some of them
sense your proximity and lower automatically. Others have a nearby
switch. Those without a switch can usually be operated by walking up to
the platform and pressing the Spacebar/Action key.

TELEPORTERS: Teleporters can be identified by an evil symbol on the
floor beneath them. To use a teleporter, walk over the symbol.

COMPLETING AN AREA
At the end of each area in DOOM there is an exit chamber, generally
marked by a special door or an “EXIT” sign. Enter this chamber and
press the switch inside to exit the area and head onward. When you
finish an area, an Achievement Screen tallies your performance. Hidden
regions located, ratio of kills, percentage of treasure found, your
completion time, and a par completion time are all displayed.

ETERNAL LIFE AFTER DEATH
If you die, you restart the level at the beginning with a pistol and some
bullets. You have no “lives” limit — you can keep restarting the level as
often as you're killed. The entire level is restarted from scratch, too.
Monsters you killed before are back again, just like you.



FIREPOWER AND HOW TO USE IT

WEAPONS: At first, you have only your pistol and your fists for
protection. When you run over a new weapon, you’ll automatically equip
yourself with it. As the game progresses, you'll need to choose between
firearms. The numeric keys select particular weapons (you cannot use
the numeric keypad keys for this selection).

The weapons are:

1 = Fist 2 = Pistol

3 = Shotguns deliver a heavy punch at close
range and a generous pelting from a distance.

4 = Chainguns direct heavy firepower into your
opponent, making him do the chaingun cha-cha.

5 = Rocket Launchers deliver an explosive rocket that
can turn several baddies inside-out.

* 6 = Plasma Rifles shoot multiple rounds of plasma

1

energy—frying some demon butt!

7 = BFG 9000s are the prize of the military’s
arsenal. Great for clearing the room of those
unwelcome guests. Shoot it and see for yourself.

FIRING: To use a weapon, point it towards the enemy and press the ‘D’
key (or other key if you have changed the Fire key in the Movement
dialog), or hold down the ‘D’/Fire key for rapid fire. If your shots hit a bad
guy, you'll see splattering blood. Don’t worry if the enemy is higher or
lower than you. If you can see a monster, you can shoot it.

AMMO: Different weapons use different types of ammo. When you run
over ammo DOOM automatically loads the correct weapon.

Small Ammo Large Ammo Weapon
Clip W Ammo Box - Pistol, Chaingun
Shells Bl Boxof Shells Shotgun

Rocket ‘ Rocket Case - Rocket Launcher
Cell - Bulk Cell - Plasma Rifle, BFG 9000

You have a maximum limit on the amount of ammo you can carry, too.
These are listed on the right side of your status bar. Also, when you find a
weapon that you already possess, don’t scorn it! Picking it up also gives
you ammo.



COMMANDS AND SHORTCUTS

You can also refer to the pull-down menus, which contain keyboard
equivalents to the following keys.

COMMAND MENU/KEY

DOOM Menu <Escape>

Automap (on/off) <Tab>

Help Control/Help, <F1>, 31

Save Game As... File/Save As, <F2>

Load Game... File/Open Saved Game, <F3>, 80
Sound & Music Volume Control/Sound Volume, <F4>, %4
Graphic Detail Control/Graphic Detail, <F5>, 85
Quicksave File/Save, <F6>, S

End Game End Game, <F7>, 87

Toggle Messages Control/Toggle Messages, <F8>, %8
Quickload File/Quickload, <F9>, #£9

Quit File/Quit, £ Q

Pause Control/Pause, 8P

Gamma Correction Control/Adjust Gamma, G

Reduce View Size ~ key

Increase View Size ‘+’ key

Keyboard Mode/Access Menubar
Mouse Enabled (No menubar access)
Joystick Enabled (No menubar access)

COMMANDS USED ONLY IN AUTOMAP
F = Follow mode (on/off) M = Mark place

Options/Keyboard, 8 K
Options/Mouse, M
Options/Joystick, $%J

C = Clear Marks

+=Zoomin - = Zoom out 0 = Full map/Zoom

WEAPONS SELECTION

1 = Fist/Chainsaw 2 = Pistol 3 = Shotgun

4 = Chaingun 5 = Rocket Launcher

6 = Plasma Rifle 7 = BFG 9000

MOVEMENT KEYS (Default Setting)
| =Move Forward .........cccoveveenveeeeaenneenn. K = Move Backward
J=Turn Left ..o L = Turn Right
U/Opt+J = Strafe Left......ccooieeeeieee O/Opt+L = Strafe Right
Shift+l = Run Forward .........ccccoevviiennnnnn. Shift+K = Run Backward
Shift+J = Fast Turn Left ......ccooviiiiiien Shift+L = Fast Turn Right
Fast Turn Right ......ccooiiiiiiiieeecieee e Shift + Right Arrow
Strafe Left ... Alt + Left Arrow
Strafe Right .......coooviiiiiicic Alt + Right Arrow



FIRING YOUR WEAPON OPENING DOORS/FLIP SWITCHES

Control Key Spacebar
Mouse Button 1 Double-click Mouse Button 2
Joystick Button 1 Joystick Button 2

TIP: When you're comfortable playing the game, try using the keyboard and
the mouse simultaneously. The mouse provides fine control for aiming your
weapon (allowing you to smoothly rotate left and right) while the keyboard
permits you to activate the many useful functions of the game.

DANGEROUS DOOM ENVIRONMENT

Some parts of the DOOM environment can be more dangerous than the
monsters you’ll face. Areas containing exploding barrels, radioactive
waste, or crushing ceilings should be approached with caution.

EXPLODING BARRELS: Scattered around the base

are drums containing fuel, toxic waste, or some other
volatile substance. If your shots hit one of these barrels, it's
kablooey time! It might take several bullets to set off a
barrel, but a single blast of any of the other weapons usually
does the trick.

SLIME AND OTHER RADIOACTIVE WASTE: Many of the areas in
DOOM contain pools of dangerous liquids that will damage you if you
walk through them. There are several varieties of waste, each doing an
increasing amount of damage. If it looks fluid, beware!

CRUSHING CEILINGS: Some of the ceilings in DOOM can smash you,
making you cry blood. Often you’ll be able to see the ceiling moving
before you go under it, but not always. Be careful and Save often!

TIP: Barrels can often be the most devastating weapon in your arsenal—
delivering a body-blasting explosion to all nearby purgatory pedestrians. Wait
until several evil guys get next to a barrel and blast away at the can, then
watch ‘em all go boom!

HEALTH AND ARMOR

Even for a tough hombre like you, DOOM can be a deadly place.
Whenever you are injured, the screen will flash red, and your health will
decrease. Keep an eye on your health or you'll end up face down.

HEALING: When you’re hurt, you’ll want to get your health back as
soon as possible. Fortunately, Medikits and Stimpacks are frequently
scattered around the base. Grab them if possible.

i Stimpacks give you a quick injection of booster enzymes
that make you feel like a new man—at least, to a degree.
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antitoxins, and other medical supplies to make you feel a
lot healthier.
ARMOR: Two types of body armor can be found laying around. Both
reduce damage done to you. Unfortunately, both deteriorate with use,
and eventually are destroyed by enemy attacks, leaving you in need
of replacement armor.

i Medikits are even better, and include bandages,

Security armor is a lightweight kevlar vest that’s perfect
.' for riot control.

Combat armor is a heavy duty jacket composed of a tita-
' nium derivative—useful for protection against real fire-
power, like the kind you’re gonna face.

If you’re wearing armor, you only pick up a replacement suit if it
provides more protection than what you’re now wearing.

POWER-UPS

Other bits of “challenging electronics” may be found in DOOM. Most of
these are pretty doggone handy, so grab them when you can. These
special items have a duration of either the entire level, a specific amount
of time, or just provide an instant benefit. A few of them affect your game
screen so you can tell when they are active. For example, when you pick
up a radiation suit, the game screen turns green. As the suit deteriorates
the screen will flash. This is a hint to get out of the radioactive ooze now!

Radiation Suits provide protection against radioactivity,
K heat, and other low-intensity forms of energy. Basically,
it these suits enable you to wade through the radioactive
ooze without taking damage. While a suit holds out, your
screen will have a greenish tint.
Duration: Time Based

Berserk Packs heal you, plus act as a super-adrenaline
- rush, enormously boosting your muscle power. Since you’re
already a pretty meaty guy, this enhanced strength lets you
tear ordinary dolts limb from limb, and you can even
splatter those demons without too much trouble. However,
you've got to use your Fist attack to get the benefit of the
Berserk attack bonus. When you become Berserk, your
screen will briefly turn red.
Duration: One Level

Backpacks increase the amount of ammo you can carry. In
addition, whenever you find a backpack, you receive extra
ammunition.
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Computer Maps are a handy find, updating your Automap
with a complete map to the entire area, including all secret or
hidden areas. Areas you haven't been to are mapped in grey.
Duration: One Level

Light Amplification Visors allow you to see clearly even in
pitch dark.
Duration: Time Based

ARTIFACTS

A few artifacts from the other dimension are now laying around and you
may want them, too.

Health Potions provide a small boost to your health —
‘ even past your normal 100%!

Spiritual Armor provides a little extra protection above and
beyond your normal armor.

Soul Spheres are strange orbs that make it difficult for
others to spot you. The enemy can still see you, but most of
their attacks will be less than accurate.

Duration: Time Based

Invulnerability Artifacts are products of the Anomaly

that render you immune to all damage. Pretty cool, until

the effect wears off. When your invulnerable your

screen will be white—your punishment for being tough.
Duration: Time Based

TIP: Create dissension among demons by maneuvering them into a crossfire.
If a bad guy is hit by another demon, he’ll turn his rage towards the poor jerk
with the pitiful aim. If this happens, let 'em at each other — it's always best to
let the bad guys do the work for you. (This isn’t effective with projectiles fired
between demons of the same form.)

THE ENEMY

From the very first moment you enter the door, till the last gunshot of the
game, you'll be fighting a host of baddies. Some are just regular guys
with a bad attitude, others are straight from Hell. Some of the monsters
you’ll face aren’t shown here. Don’t say we didn’t warn you.

Former Humans: Just a few days ago, you were probably
swapping war stories with one of these guys. Now it’s time to
swap some lead upside their head.

Former Human Sergeants: Same as above, but much A
meaner, and tougher. These walking shotguns provide

you with a few extra holes if you're not careful!
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Imps: You thought an imp was a cute little dude in a red suit with a
pitchfork. Where did these brown bastards come from? They heave
balls o’ fire down your throat and take several bullets to die. It's
time to find a weapon better than that pistol if you're going to face
more than one of these S.0.B.s.

Demons: Sorta like a shaved gorilla, except with horns, a bi head,
lots of teeth, and harder to kill. Don't get too close or they’ll rip your
fraggin’ head off.

& Spectres: Great. Just what you needed. An invisible
(nearly) monster.

Lost Souls: Dumb. Tough. Flies. On fire. 'Nuff said.
“ Cacodemons: They float in the air, belch ball-lightning, and boast

one Hell of a big mouth. You're toast if you get too close to these
monstrosities.

Barons of Hell: Tough as a dump truck and nearly as big,
these goliaths are the worst thing on two legs since
Tyrannosaurus rex.

Note: The above illustrations are not drawn to scale.

If you have read the instruction manual and the addendum, but still
require further assistance running The Ultimate DOOM, you can do the
following:

1. Call GT Interactive’s Technical Support at (970) 522-1797, Monday
through Friday, 8 AM through 12 midnight Eastern Time (closed on major
holidays). If possible, please be near your computer when calling. Have
as much information regarding your system setup and configuration, as
well as detailed information about where you are encountering a problem
and any messages you receive on screen.

2. Access on-line technical information at the GT-WEB site at
http://www.gtinteractive.com. In the “Support Section” you can
access lists of frequently asked questions and troubleshooting tips,
forum discussions where technical issues are raised, and direct E-mail
support at support@gtinteractive.com. Upgrade patches will also be
made available here for download when released.

3. Mail your questions to: GT Interactive Software
Attention: TS/Q&A
1 Nixon Lane
Edison, NJ 08817

IMPORTANT: Before changing your system or software setup we
recommend that you review your system manuals to ensure that your
modifications will not endanger any existing information or hardware on
your system or networks. Modifying your system or your software setup
can be dangerous and we cannot help you with any resulting problems.
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